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Chapter 1

OctaMED

1.1 The Sample Editor

PURPOSE
For editing and digitizing ‘samples’, the most often-used type of
instrument.

HOW TO OPEN
Display menu; Main Control’s Edit button (unless the current Where?
instrument is of type Synth). Where?

MENU STRIP

* Project
> Flush Sample More

Removes the current instrument from memory and clears all its
properties.

> Load Sample More
Loads a sample from disk.

> Save As... More
Saves the sample in one of five different formats.

> Exit Sample Editor
Closes the sample editor window.

* Edit
> Cut More

Copies the range to the copy buffer, then removes it.
> Copy More

Copies the range to the copy buffer.
> Paste More

Inserts the copy buffer at the start of the range, increasing
the size of the sample.

> Paste (Overwrite) More
As Paste, but overwrites the existing sample contents. The
sample’s length is unchanged.

> Erase More
Removes the range (without copying it to the copy buffer).

> Erase To Start More
Erases from the sample’s start to Range End.

> Erase To End More
Erases from Range Start to the sample’s end.

> Clear More
Blanks the range.
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> Reverse More
Turns the range backwards.

> Invert More
Turns the range upside-down.

> Chop More
Erases the non-ranged parts of the sample. Only the ranged
section is left.

> Remove Unused Space More
Erases empty space (i.e. of zero or very little volume) on
either side of the waveform.

> Adjust Y More
Opens window:

Adjust Y
.

Moves the range up or down on the waveform display.
> Centralize More

Centers the range about the white zero line. (A special case
of Adjust Y.)

* Tools
> Play Buffer Contents More

Plays the contents of the copy buffer at the current pitch.
> Sample <-> Buffer More

Swaps the sample with the copy buffer.
> Discard Copy Buffer More

Frees up the memory occupied by the copy buffer.
> Add Workspace

Opens window:
Add Workspace

.
Adds blank space to the sample, before e.g. doing an echo.

> Calculate Range Time More
Works out the time taken to play the range at the current
pitch (to the nearest .001 second).

> Play Tune Tone More
Plays a ‘sine’ sound at the current pitch, for instrument
tuning purposes. Stop it using the space bar.

> Copy Pitch More
Copies the current pitch to the instrument’s default pitch
or vice-versa.

> Raw Sample Conversion More
+ For correcting very distorted and noisy Raw samples.
- Unsigned <-> Signed

Swaps the sample between signed and unsigned format.
OctaMED’s samples are stored in signed format, but most
samples originating on PCs are unsigned.

- Swap Byte Order
Swaps the order of 16-bit sample bytes.
> Copy to Synth Editor More

Transfers the first 128 bytes of the current range to the
synthetic sound editor’s right-hand waveform display.

* Effects
> Change Volume

Opens window:
Change Volume

Changes the range’s volume.
> Change Pitch

Opens window:
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Change Pitch
Changes the pitch of the whole sample.

> Mix
Opens window:

Mix
Mixes the whole sample (or range) with the copy buffer.

> Filter/Boost
Opens window:

Filter/Boost
Muffles/brightens the range.

> Echo
Opens window:

Echo
Echoes part of the range over the rest of the range.

> Create Noise
Opens window:

Noise
Adds white noise (hiss) to the range.

> Create Chord
Opens window:

Chord Creation
Mixes together several different pitches of the sample.

* Loop
> Show Loop More

Magnifies the loop to fill the whole display.
> Snapshot Loop More

Stores the current loop position in memory.
> Recall Loop More

Retrieves the stored loop position.
> Mark More

Loops the range, current display or whole waveform.
> Find Zero Loop In More

Does a 0> to the loop start pointer and <0 to the loop end.
> Find Zero Loop Out More

Does a <0 to the loop start pointer and 0> to the loop end.
> Play Loop More

Plays the loop repeatedly (press space bar to stop).
> Range = Loop More

Marks a range over the loop.
> Erase Before Loop More

Erases from the sample start to the loop start.
> Erase After Loop More

Erases from the loop end to the sample end.

* Settings
> Display Settings

Opens window:
SampleEd Disp Settings

Contains settings related to the waveform display.
> Sampler Voice Monitor More

On: During digitizing, the sound you are sampling is audible.
Only applies to 8-bit samples.

> Create Icons For Samples More
On: Saves a Workbench icon file with saved samples.

WAVEFORM DISPLAY

* Squiggly black line More
The sample’s waveform (or ‘No sample loaded.’).
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* Scroll bars
> Horizontal More

The size and position of the displayed portion of the sample
relative to the whole sample. Use it to scroll around the
sample after zooming in.

> Vertical More
One way of magnifying and reducing the display. Drag it
up to zoom in, down to zoom out.

* Loop pointers More
+ The dotted lines over the waveform, connected to the small

triangles in the rectangle immediately below the waveform.
+ They mark a repeated part of the sample (and may not exist).

* Range More
+ A particular part of the sample, highlighted in white.
+ Mark a range by holding the left mouse button and dragging

over the waveform.

GADGETS

* Above the waveform display
> Information box (‘Display: n’) More

Number of bytes currently being displayed in the waveform.
Equal to Buffer unless you have zoomed in.

> Buffer More
The size of the current sample. Can enter a new value.

> Range Start More
The position, in bytes, of the start of the range.

> Range End More
The position, in bytes, of the end of the range.

* Section immediately below waveform display
> Play Display More

Plays the current display at the current pitch.
> Zoom In / Out More

Magnifies/reduces the sample.
> Show All More

Restores the whole sample to view. For use after zooming in.
> Range Display More

Marks a range over the whole display (not the whole sample).
> Sample< More

Copies the copy buffer to the sample.
> >Buffer More

Copies the whole sample to the copy buffer.
> Monitor More

- Current instrument’s output device set to Amiga
Displays the signal coming from your sampler in a black
area at the bottom. Use to adjust the signal’s volume.

- Output device set to Aura
Opens a black area which displays the Aura input signal.

- Output device set to Toccata
Opens window:

Toccata Capture
Digitizes through your Toccata 16-bit sound board.

> Digitize More
- Output device set to Amiga or Aura

Opens the monitoring area. Click inside the area with the
left mouse button to start digitizing (‘sampling’), or the
right mouse button to cancel.

- Output device set to Toccata
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Opens window:
Toccata Capture
Digitizes through your Toccata 16-bit sound board.

> Pitch More
- Number box

Current pitch (playing frequency), in Hz.
- Pitch box

Note equivalent to this frequency (or --- if there is no
equivalent note).

* Lower section
> Freehand More

- On
Can edit the waveform by drawing with the mouse. The
maximum display size is 596 bytes.
> Loop More

- On
The sample has a loop, a section of the sample that is
continually repeated (‘looped’) until it is stopped.
> Loop Point More

- Start/End
Selects whether the other Loop Point gadgets affect the
loop start or loop end pointer.

- Arrows
Move the selected pointer left/right in very small steps.
(If clicked with Shift held, move to the sample start/end.)

- <0 and >0 More
Search for a zero value (having no volume) to the left or
right. (Loops starting and ending at zero are often pretty
good.)
> Stereo gadgets [only apply to stereo samples] More

- S button
Shows both halves of the sample in the waveform display,
just the left half, or just the right half, alternately.

- Left-hand information box More
For mono samples, shows Mono. For stereo samples, shows
L><R, L> or <R (referring to the waveform display). Shows
8 for 8-bit and 16 for 16-bit.

- Right-hand information box
A duplicate of the left-hand box, for the copy buffer.
(Can also show B:Empty if there is nothing in the buffer.)

* Range section
> Show More

Magnifies the range to fill the whole display.
> Play More

Plays the range at the current pitch.
> Cut More

Copies the range to the copy buffer, then removes it.
> Erase More

Removes the range (without copying it to the copy buffer).
> Clear More

Blanks the range.
> Copy More

Copies the range to the copy buffer.
> Paste More

Inserts the copy buffer at the start of the range, increasing
the size of the sample.

> Reverse More
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Turns the range backwards.

1.2 The Toccata Capture Window

PURPOSE
Digitizes (‘samples’) from your Toccata sound board, if you have More
one. (If you don’t have one, you’ll never see this window!)

HOW TO OPEN
1) Set the current instrument’s output device to Toccata How?
2) In the Sample Editor, click Monitor or Digitize.

Where?
GADGETS

* Upper section
> Level Display Active

- On
Activates two black input level bars. Use when setting the
input volume level.
> Two display boxes

The input level bars. There’s a separate bar for each half
of a stereo sample (left and right). For mono samples, the
bars move together.

* Input section
> Radio button

Selects the Toccata input that should be used.
> Mic Gain

- On
Turns the microphone preamplifier on.
> Level

The input level. Adjust the slider to change the volume of
the sample.

> Loopback
The extent to which the input signal is fed back through the
output sockets. The further right, the louder the sound
played back through Toccata.

* Lower section
> Sampling Rate

The frequency of this sample. Toccata can sample and play
back at 14 different frequencies, from 5513 Hz to 48 kHz.

> Capture
Immediately begins digitizing. To interrupt the process,
click Stop in the requester that appears.

> Exit
Closes the window.

1.3 The Adjust Y Window

PURPOSE
To move the range up or down.

HOW TO OPEN
Sample editor’s Edit menu.
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Where?
GADGETS

* Main section
> Adjust by

The required amount of adjustment (-128 to 127). Negative
numbers move the range downwards.

> Calculate Average Deviation
Works out the required adjustment to ‘centralize’ the range. More

* Bottom
> Adjust

Performs the operation. (Shift-click to close the window.)
> Exit

Closes the window.

1.4 The Add Workspace Window

PURPOSE
Adds extra blank space (of zero volume) to the sample’s extremes. More

HOW TO OPEN
Sample editor’s Tools menu.

Where?
GADGETS

* Main section
> Factor

The bytes of space to add as whole multiples of the sample
size. (E.g. if sample size = 2000, Factor 3 gives 6000 bytes)

> Adjust
Adds that little bit extra on to the Factor value, as a
percentage. (For a factor of 2½: Factor = 2, Adjust = 50%)

> Bytes
The number of bytes of space to add. Can type in directly.

> Add to
- End

Adds the space to the end of the sample.
- Start

Adds the space to the start of the sample.

* Bottom
> Add Workspace

Performs the operation. (Shift-click to close the window.)
> Exit

Closes the window.

1.5 The Change Volume Window

PURPOSE
Changes the volume of the current range. More

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS
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* Upper section
> Start

The percentage volume change of the very start of the range.
> End

The percentage volume change of the very end of the range.
> Check Clip

- Off
Distortion is allowed to occur if the volume is increased
by too much.

- On
The amount of allowed distortion (or ‘clipping’) is given
by Max Clip. If 0 %, no distortion can occur.
> Max Clip

The percentage of possible distortion, if Check Clip is on.

* Lower section
> Fade In

Changes volume from 0 % to 100 %.
> Fade Out

Changes volume from 100 % to 0 %.
> Halve

Changes volume from 50 % to 50 %.
> Double

Changes volume from 200 % to 200 %.
> Max

Changes to the highest possible volume without distortion.

* Bottom
> Change Volume

Performs the effect. (Shift-click to close the window too.)
> Exit

Closes the window.

1.6 The Change Pitch Window

PURPOSE
Changes the pitch of (‘retunes’) the whole sample. More

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS

* Upper section
> Source Freq

- Number box
The frequency at which OctaMED assumes the sample was
originally digitized. Can be any value, though.

- Pitch box
The pitch, if any, corresponding to that frequency.
> Dest. Freq

- Number box
The required new frequency.

- Pitch box
The pitch, if any, corresponding to that frequency.

* Lower section
> Octave Up

Retunes the sample one octave up, halving the sample’s size.
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> Octave Down
Retunes the sample one octave down, doubling the sample.

> Cancel Finetune
Retunes the sample so that its Finetune value is no longer More
needed.

> Anti-Alias
- On

Reduces noise when retuning downwards (lowering the pitch).

* Bottom
> Change Pitch

Performs the effect. (Shift-click to close the window too.)
> Exit

Closes the window.

1.7 The Mix Window

PURPOSE
Mixes the current sample with the copy buffer, storing the result More
in the current sample.

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS

* Main section
> Source Level

The volume of the sample in the copy buffer.
> Dest. Level

The volume of the current sample. To prevent distortion, the
two levels should add up to (at most) 100 %.

* Bottom
> Mix

Mixes. (Shift-click to close window.) The result is stored in
the current sample, from Range Start. If a range is marked,
only that part is changed.

> Exit
Closes the window.

1.8 The Filter/Boost Window

PURPOSE
Filters (muffles) or boosts (brightens) the range. More

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS

* Main section
> Averaging

The strength of the filter/boost. Higher is stronger.
> Distance

A special effect - try it! (Works best at value 128.)
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* Bottom
> Filter

Performs filtering. (Shift-click to close the window too.)
> Boost

Performs boosting. (Shift-click to close the window too.)
> Exit

Closes the window.

1.9 The Echo Window

PURPOSE
Echoes part of the range over the rest of the range. More

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS

* Main section
> Echo Rate

The distance, in bytes, between each echo.
> Volume Decrease

The rate at which the echo will fade away. Low values mean
low rates. Value 0 spreads the volume evenly.

> Number of Echoes
The total number of echoes produced. Usually low (1 - 10).

* Bottom
> Do Echo

Performs the effect. (Shift-click to close the window too.)
> Exit

Closes the window.

1.10 The Noise Window

PURPOSE
Adds white noise (hiss) to the range. Needs creative use! More

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS

* Main section
> Level

The volume of the produced noise.

* Bottom
> Create Noise

Performs the effect. (Shift-click to close the window too.)
> Exit

Closes the window.

1.11 The Chord Creation Window
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PURPOSE
Creates chords of two to four notes from the current sample. More

HOW TO OPEN
Sample Editor’s Effects menu.

Where?
GADGETS

* Left section
> Base Note

The note to which the other chord notes relate. (The ‘bass
note’ really.)

> Chord Note 1 to 3
The other notes of the chord. (Some may be blank if desired.)

* Middle section
> Major

Sets a major chord (C E G).
> Minor

Sets a minor chord (C D# G).
> Sus 4th

Sets a suspended 4th chord (C F G).
> Major 6

Sets a major 6th chord (C E G A).
> Minor 6

Sets a minor 6th chord (C D# G A).
> Dominant 7

Sets a dominant 7th chord (C E G A#).
> Major 7

Sets a major 7th chord (C E G B).
> Minor 7

Sets a minor 7th chord (C D# G A#).

* Right section
> Inversion

- Root
The base note of the chord is lowest.

- First/Second/Third
Chord Note 1/2/3 is lowest.
> Basic

- Minor/Major/Sus 4th
3/4/5 halfsteps between Base Note and Chord Note 1.
> Third

- Diminished/Normal/Augmented
6/7/8 halfsteps between Chord Note 1 and 2.
> Fourth

- Sixth/Dominant/Major
9/10/11 halfsteps between Chord Note 2 and 3.

* Bottom
> Erase Trailing Notes

- Off
The chord notes will not end together (because higher
notes are shorter than lower notes).
- On

Shortens the sample so that the notes end together.
> Full Volume

- Off
The volume decreases.
- On
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The volume may distort (no division by the number of
notes in the chord is performed).

> Create Chord
Performs the effect. (Shift-click to close the window too.)

> Play Chord
Previews the chord (one chord note is played through each
sound channel, unlike the final one-channel chord).

> Mute
Stops the chord playing.

> Exit
Closes the window.

1.12 The SampleEd Disp Settings Window

PURPOSE
Contains settings related to the waveform display. More

HOW TO OPEN
Sample Editor’s Settings menu.

Where?
GADGETS

* Main section
> Display Type More

Displays the waveform using lines or pixels.
> Pixel Density More

The density of the pixels used when Display Type is Pixel.
> Minimum Zoom More

The minimum value of the Display information box.
Where?

> Center Zoom Slide on Range More
- Off

Dragging the waveform display’s vertical scroll bar zooms
in towards the center of the sample.

- On
Zooms in towards the center of the current range.
> Fast Graphics More

- On
The waveform display updates quickly.

- Off
About 5K of memory is saved, at the expense of speed.

* Bottom
> Exit

Closes the window.

1.13 The Sample List Editor

* Note: In this window, ‘sample’ and ‘instrument’ are (as often)
used interchangeably.

PURPOSE
To create and maintain a list of all your instruments. (Applies to More
all types of instrument, despite the window’s name.)
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HOW TO OPEN
Display menu. Where?

MENU STRIP

* Project
> Load List

Loads a sample list from disk. The new list can replace or
be added to the end of (‘appended to’) the old list.

> Clear List
Clears the entire list.

> Statistics
Gives statistics such as the number of samples in the list.

* Format More
> 8-Bit Samples

The file type used when saving 8-bit samples (using the Save
Ins or Save All Ins buttons).

> 16-Bit Samples
The file type used when saving 16-bit samples.

GADGETS

* Instruments and Directories list boxes
List the directories in your sample list, and the instruments
in the selected directory. Select a directory by clicking on
its name. If you don’t have a sample list, the boxes are blank.

* Buttons under the Instruments box
> Add More

Adds the current instrument (in the song) to the sample list,
in the selected directory. Also adds most of its properties.

> Remove More
Click on an instrument name then click Remove to remove it
from the list.

> Save Ins More
Adds the current instrument to the selected directory, and
also saves it to disk.

> Del Ins More
Removes the selected instrument, and also deletes it from
disk.

* Buttons under the Directories box
> Add Dir More

Opens a file requester to add a directory to the list.
> Remove Dir More

Removes the selected directory from the list.
> Save List More

Saves the list to disk. If saved under the default name, the
list will be automatically loaded when OctaMED starts up.

* Instrument properties gadgets More
> Name, Volume, Pitch, Repeat, RepLen, Transpose, Finetune,

MIDI Ch, MIDI Pres
The selected instrument’s name, relative volume, default
pitch, loop start, loop length, transpose value, finetune
value, MIDI channel and MIDI preset.

* Lower-left section
> Load Inst

Loads the selected instrument.
> Save All Insts More

Adds all instruments in the song to the selected directory,
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and also saves them to disk.

* Bottom
> Exit

Closes the window.

1.14 The MIDI Message Editor

PURPOSE
Sends, receives (‘captures’), edits and stores MIDI data. More
Especially suitable for System Exclusive (SysEx) messages.

HOW TO OPEN
Display menu. Where?

GADGETS

* Main area
The current message, in hexadecimal bytes. Blank if no messages
exist.

+ Editing the message More
- Turn Edit mode on.
- Use the cursor keys to move around.
- Use 0-9 and A-F to edit the message.
- Del deletes the current byte, Shift-Del inserts a new one.

* Msg section (below the main area on the left)
> Number box

The current message’s number.
> Arrows

Select a message.
> Information box (just before New Msg)

Number of final message.

* Buttons in the window’s middle
> New Msg

Adds a new message, 8 bytes long, after the final one. If no
messages exist, click New Msg to create a new one.

> New Here
Inserts a new message before the current one.

> Del Msg
Removes the current message.

> Clear Msg
Clears the current message (sets all bytes to zero).

* Msg Size section
> Number box

Size of the current message (in bytes). Default is 8, but
SysEx messages are much larger, so type in a new size.
Maximum size is 1048560 bytes (just under 1 megabyte).

> Name
For naming a message (optional but recommended).

> Save Msg
Saves the current message to disk.

> Load Msg
Loads a message from disk.

> Capture Msg More
Click to begin receiving a MIDI message (or other data).
Click again to interrupt receiving (automatically stops if
the message becomes full).
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> Send Msg More
Sends out the current MIDI message.

> Auto-Terminate Capture
- On

Stops receiving when an End SysEx byte is received.
- Off

Ignores End SysEx bytes ($F7).
> Information box

Shows ‘Recording...’ during message capturing.
> Exit

Closes the window.

1.15 The Input Map Editor

PURPOSE
To re-assign all the input keys on your keyboard (especially MIDI More
keyboard). Allows you to control OctaMED by pressing keys on your
MIDI keyboard, rather than using the mouse or Amiga keyboard.

HOW TO OPEN
Display menu. Where?

GADGETS

* List box
> Left-hand column

MIDI note numbers in decimal.
> Middle column

MIDI note numbers in hexadecimal.
> Right column

The action when each MIDI note is input. Can be entering a
note or something controlled by the Action section. The note
is a ‘full note’. More

+ The list is blank if no map is defined (click Create New Map).

* Middle section
> Map Active

- On
The input map is used.

- Off
The input map is ignored.
> Create New Map

Starts a new input map.
> Delete Map

Removes the input map, freeing up some memory.
> Reset Selected

Resets the selected key (in white) to its original function.
> Load Map

Loads a new input map from disk.
> Save Map

Saves the input map to disk.

* Action section More
> Cycle gadget

- None
The selected key (in white) enters a note/player command.

- OctaMED Command
Executes an OctaMED ARexx command (type it into the Command
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box, with any required parameters).
- Execute ARexx File

Executes an ARexx script (type its name into Command).
- Ext. ARexx Command

Sends an ARexx command to another program (type the command
into Command, the program’s ARexx port into ARexx Port).

- Launch Program
Launches (runs) an executable program (type its filename
into Command).
> Command

Varies according to the above cycle gadget’s setting.
> ARexx Port

The other program’s ARexx port name (if appropriate).

* Bottom
> Exit

Closes the window.

1.16 The ARexx Trigger Setup Window

PURPOSE
Sets player commands (of type 2D) to execute an OctaMED ARexx More
command or ARexx script, send an ARexx command to another program,
or load and run a program from disk.

HOW TO OPEN
Display menu. Where?

GADGETS

* Upper section
> Slider

The player command currently being edited (2D01 - 2DFF).
> Clear Current

Sets the current command’s action to None.
> Clear All

Sets all commands’ actions to None.

* Action More
+ What the player command is to do if it appears in a song.
> Cycle gadget

- None
The player command has no effect.

- OctaMED Command
Executes an OctaMED ARexx command (type it into the Command
box, with any required parameters).

- Execute ARexx File
Executes an ARexx script (type its name into Command).

- Ext. ARexx Command
Sends an ARexx command to another program (type the command
into Command, the program’s ARexx port into ARexx Port).

- Launch Program
Launches (runs) an executable program (type its filename
into Command).
> Command

Varies according to the above cycle gadget’s setting.
> ARexx Port

The other program’s ARexx port name (if appropriate).
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* Bottom
> Exit

Closes the window.

1.17 The Song Selector Window

PURPOSE
Multi-module management. Add, delete and select songs. More

HOW TO OPEN
Song menu; Information window’s Sg button (far left). Where?

GADGETS

* List box
Shows all song numbers and names. The song currently being
edited is highlighted in blue; select one by clicking on it.

* Others
> Text box

The name of the selected song (changeable).
> Add New

Adds a new song after the last one.
> Add Here

Inserts a new song before the selected one.
> Delete

Removes the selected song.
> Select

Selects the selected song for editing, and closes the window.
> Exit

Closes the window.

1.18 The Playing Sequence Window

PURPOSE
Controls the order in which to play blocks. This order is used when More
Song Play (Main Control) is clicked.

* Collection of blocks + a playing sequence = a song.

HOW TO OPEN
Song menu; Information window’s Sq button (just left of center). Where?

GADGETS

* List box
+ The playing sequence. The blue bar marks the current position;

select a new position by clicking on one.
- Left column

Playing sequence position numbers.
- Middle column

Block numbers at each position. A block can appear more than
once or not at all in the playing sequence.

- Right column (after the colon)
The names of the blocks at each position.
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* Row immediately below the list box
> Number box

The block number of the current position (changeable).
> Arrows

Used to change the number box’s contents. If the current
position is below the last position, < deletes the last
position and > adds block 000 to the end of the sequence.

> Information box
Format is ‘a/b’, where:

a: The current position number
b: The total number of positions in the sequence.
> Follow

- On
During play, the sequence is scrolled so that the current
position is always visible in the window (‘followed’).

- Off
The current position is not followed. Allows you to scroll
freely around the list while playing the song.

* Eight editing buttons
> Top

Selects the first position.
> Bottom

Selects the last position.
> Insert

Duplicates the current position.
> Ins Curr

Inserts a new position - the current block - before the
current position.

> Append
As Insert, but adds to the end of the sequence.

> App Curr
As Ins Curr, but adds to the end of the sequence.

> Delete
Deletes the current position.

> Clear
Clears the playing sequence (or current section).

* Lower section
> Name

The name of the current section (changeable). Note: When more
than one playing sequence exists, each sequence is called a
‘section’.

> New Sec
Adds a new section after the last one.

> New Sec Here
Inserts a new section before the current one.

> Delete Sec
Deletes the current section.

> Sec:
- Number box

The number of the current section.
- Arrows

Used to change the number box’s contents.
- Information box

Total number of sections in the song.

* Bottom
> Exit
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Closes the window.

1.19 The Section List Window

* Note: Here, ‘playing sequence’ and ‘section’ are used
interchangeably.

PURPOSE
Controls the order in which to play song sections (multiple playing More
sequences). The section list orders playing sequences; each playing
sequence orders blocks.

HOW TO OPEN
Song menu; Information window’s Sc button (just left of center). Where?

GADGETS

* List box
+ The section list. The blue bar marks the current position;

select a new position by clicking on one. Shift-click a
position to show that section in the Playing Sequence window.

- Left column
Section list position numbers.

- Middle column
Section numbers at each position. A section can appear more
than once or not at all in the section list.

- Right column (after the colon)
The names of the sections at each position.

* Row immediately below the list box
> Number box

The section number of the current position (changeable).
> Arrows

Used to change the number box’s contents.
> Information box

Format is ‘a/b’, where:
a: The current position number
b: The total number of positions in the list.
> secs information box

The total number of sections in the song.

* Buttons
> Insert

Inserts a new position - section 001 - before the current
position.

> Append
Adds a new position - section 001 - to the end of the list.

> Delete
Deletes the current entry.

> Exit
Closes the window.

1.20 The Song Options Window
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PURPOSE
Contains some options related to the whole song. The options can be
different for each song of a multi-module. More

HOW TO OPEN
Song menu. Where?

GADGETS

* Top
> Name More

Name of the current song. Also displayed on the title bar.

* Channel Mode More
+ Six buttons, but three fundamentally different methods of

playing the song.
> 4 Channels/MIDI More

Selects ‘normal’ play (4-channel sound, or MIDI). More
> 5, 6, 7, 8 Channels More

Selects simulated 5 to 8-channel play. Samples should be
‘halved’ in volume.

> 1-64 Ch Mixing More
Selects ‘mixed’ play (up to 64 channels). Needs at least a
68020 processor for decent results.

+ Shift-click a button to convert between Mix mode and other modes
(transposes notes and the Oct gadget up/down 2 octaves).

* Other Options
> Cycle gadget More

- Decimal Volumes
In the Tracker editor, displays volume command (0C) levels
in decimal.

- Hex Volumes
Displays player command 0C levels in hexadecimal.
> Convert More

Converts decimal 0C levels to hex and vice-versa.
> Audio Filter Active

- On
Turns the low-pass audio filter on. (Muffles the sound, and
brightens the Amiga’s power light.)

- Off
Turns the filter off - sound quality is usually better.
> High Quality Mode More

- On
Enhances audio quality in 5 to 8-channel mode. Requires at
least a 68020 processor in 7 and 8-channel modes.
> No Slide On 1st Tick More

- On
No slides (player commands 01/02/03/05/06/0A/0D) are done
on the first tick of each line. For Tracker compatibility.

* Bottom
> Play Transpose More

Transposes the whole song. (Doesn’t actually change the
notes, just affects playing.) Range is \ensuremath{\pm} 1 octave.

> Exit
Closes the window.
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1.21 The Relative Track Volumes Window

PURPOSE
To adjust the volume of each track, relative to the master volume. More

HOW TO OPEN
Song menu. Where?

GADGETS

* Main section
> Numbers along the top

Track numbers.
> Sliders

Adjust the volume of each track.
> Arrows

Shift all track numbers down/up by 8.

* Right-hand section
> Master slider

The master volume. Track volumes are relative to the master
volume. E.g. if both the master and a track is at half
volume, the track is really at quarter-volume.

* Bottom
> Exit

Closes the window.

1.22 The Song Annotation Window

PURPOSE
To attach any text to your song. The text might be a copyright More
notice, the author’s name, explanatory text, or greetings.

HOW TO OPEN
Song menu. Where?

GADGETS

* Top
> Long text box

For brief text. Displayed on the screen’s title bar whenever
the song is loaded.

* Main section
> Load Text

Loads a text file on disk, and displays it.
> Save Text

Saves the displayed text to disk.
> Discard Text

Removes the displayed text.
> Show After Loading

- On
Opens the Song Annotation window straight after loading,
to display the text.

- Off
Does not open the window - only shows the title bar text.
> Rectangular area

The displayed text, if any. Tab characters cannot be used.
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1.23 The Block Properties Window

PURPOSE
To change the properties of the current block. More

HOW TO OPEN
Block menu; Information window’s B button, with Shift held. Where?

* Main section
> Name More

The current block’s name.
> Tracks More

The number of tracks in the current block (1 - 64). No
confirmation requester when the number is reduced!

> Length More
- Number box

The number of lines in the current block (1 - 3200).
- Single arrows

Change the length in steps of 1 line.
- Double arrows

Change the length in steps of 10 lines.
> Cmd Pages More

- Number box
The number of player command ‘pages’ in the current block.

- Arrows
Used to change the number box.

* Bottom
> Exit

Closes the window.

1.24 The Block List Window

PURPOSE
An at-a-glance list of blocks and some commonly-used functions.

HOW TO OPEN
Block menu; Information window’s B button.

GADGETS
> List box More

The block list. The blue bar marks the current block; select a
new block by clicking on one. Shows block numbers and names.

> Text box More
The current block’s name (changeable).

> Insert New More
Inserts a new block before the current block.

> Append New More
Adds a new block after the final block.

> Ins to Seq More
Inserts the current block’s number at the current playing
sequence position.

> App to Seq More
Adds the current block’s number to the end of the playing
sequence.
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> Delete More
Deletes the current block.

> Show Unused More
- On

Any block that hasn’t been used in the playing sequence is
marked with a * in the list.

> Exit
Closes the window.

1.25 The Highlight Options Window

PURPOSE
Highlights the current block’s lines in a regular fashion. More
Highlighted lines are shown in bold.

HOW TO OPEN
Block menu. Where?

GADGETS

* Main section
> 1, 2, 3, 4, 6, 8, 16, 32

Highlight every line, 2nd line, 3rd line and so on.
> Clear

Un-highlights all the lines in the block.
> Offset

The number of the first line to be highlighted.
> Spacing

A custom spacing between highlighted lines. Try e.g. 12.

* Bottom
> Exit

Closes the window.

NOTE
Highlighting an already highlighted line removes the highlighting.

1.26 The Expand/Shrink Block Window

PURPOSE
Expands or shrinks the current block. More

HOW TO OPEN
Display menu. Where?

GADGETS
> Factor

The amount of expansion or shrink.
> Expand

Inserts f new line(s) after each existing line, where f is the
Factor value minus 1. Increases the number of lines in the
block by a factor of f (e.g. Factor 2 doubles the block).

> Shrink
Removes every fth line, where f is the Factor value. Decreases



OctaMED 24 / 25

the number of lines by a factor of f (e.g. 2 halves the block).

1.27 The Instrument List Window

PURPOSE
A selectable list of the instruments in the song. More

HOW TO OPEN
Instr menu. Where?

GADGETS
> List box
+ The instrument list. The blue bar marks the current instrument;

select a new instrument by clicking on one.
- Left column

Instrument numbers.
- Middle column

Instrument names (blank for nameless instruments).
- Right column (to the right of /)

Instrument sizes, and other properties. Empty instrument More
positions have size -------.

> Exit
Closes the window.

1.28 The Instrument Type Window

PURPOSE
Selects the current instrument’s type. More

HOW TO OPEN
Instr menu; Main Control’s Type button. Where?

GADGETS
> Radio button
- Sample

The current instrument is a sample, the usual type.
- Hybrid More

As Sample, but can be controlled using the same commands as
synthsounds. So a cross between Sample and Synthetic.

- ExtSample More
Adds two lower octaves to the Sample range. In Mix mode,
Samples and Hybrids also have these new octaves.

- Synthetic More
A synthsound. Created using the Synthetic Sound Editor.

- 16-bit More
For use with 16-bit sound boards (Aura, Toccata, MaestroPro,
Delfina). Other instrument types are 8-bit. You can convert
between 8 and 16-bit types without any problem, but 16 to
8-bit conversion reduces quality.

> Octaves slider
The number of octaves in the current sample (1 - 7). Moving the
slider often corrupts the sample.
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> Stereo [not for Synthetic types] More
- Off

The sample is in mono.
- On

The sample is in stereo. Mono to stereo conversion requires
double the sample’s size in free memory.

> Output Device
- Amiga

The sample should be played through the Amiga.
- Aura

Played through HiSoft’s 16-bit Aura sound board.
- Toccata

Played through the Toccata 16-bit sound board. This is only
visible if the board is connected.

> Exit
Closes the window.

NOTE
An instrument of any type can be MIDI, if its MIDI channel number More
is greater than 0.


	OctaMED
	The Sample Editor
	The Toccata Capture Window
	The Adjust Y Window
	The Add Workspace Window
	The Change Volume Window
	The Change Pitch Window
	The Mix Window
	The Filter/Boost Window
	The Echo Window
	The Noise Window
	The Chord Creation Window
	The SampleEd Disp Settings Window
	The Sample List Editor
	The MIDI Message Editor
	The Input Map Editor
	The ARexx Trigger Setup Window
	The Song Selector Window
	The Playing Sequence Window
	The Section List Window
	The Song Options Window
	The Relative Track Volumes Window
	The Song Annotation Window
	The Block Properties Window
	The Block List Window
	The Highlight Options Window
	The Expand/Shrink Block Window
	The Instrument List Window
	The Instrument Type Window


